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Scan EZ 
 Scans photos and documents to USB and email 
 Located at the Second Floor and Kids department 
 Copy time: Approximately 5 seconds per page  

Vinyl to MP3 
 Located in the Creative Studio Room B 
 Copy time: Length of Record 

Cassette to MP3  
 Located in the Creative Studio Room B 
 More difficult to use  
 Copy time: Length of Cassette 

VHS to DVD or Digital File 
 Located in the computer commons area  
 Four check-out converters available for home use 
 Copy time: Length of VHS 
 Elgato Video Capture, with computer & software, create MP4 

video files 

DVD to DVD & CD to CD (Duplicator) 
 Located near the copiers 
 Extremely easy to use 
 Cannot copy copyrighted DVDs  
 Copy time: 2-7 min 

Negative/Slide Scanner 
 Located at Creative Studio & Extraordinary Things Collection 
 Copy time: a few seconds per slide/negative 

Film to Digital (Wolverine MovieMaker) 
 Located in Extraordinary Things Collection 
 Converts 8mm and Super 8 film reels to digital MP4 files (will 

not convert audio) 
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Scan EZ Station 

Flat-Bed Scanner  

 Available in public computer area and Creative Studios 

 Control settings with provided graphics software 

 Scan documents, books, pictures, negatives and slides 

 Save as PDF, JPEG, TIFF and other format 

 Online Help – files.support.epson.com/htmldocs/prv3ph/
prv3phug/index.htm 

 Available on Second Floor and Kid’s Library 

 Easy-to-use touch screen; 11 x 17 scan bed 

 Scan pictures, documents, books to: 

 USB, FAX, Email, Smart Phone/Tablet  
or GoogleDrive (all but FAX are free*).  

 Save scans as: 

 PDF, Searchable PDF, Word Doc, TIFF, JPEG  

 Color, Grayscale, Black and White 

 Standard or High Quality Resolution 

 20 MB limit on email 

*FAX your scan for a flat rate: $1 Domestic/$5 International 

 Available on Second Floor  

 Scans photos and documents to USB 

 Saves as PDF, Tiff, or JPEG 

 Great for multi-page documents 

Copiers 

https://files.support.epson.com/htmldocs/prv3ph/prv3phug/index.htm
https://files.support.epson.com/htmldocs/prv3ph/prv3phug/index.htm
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How to Use the Epson Flat-Bed Scanner and Software:  

1. Open the “Epson Scan” application on the desktop and choose your settings: 

 Mode: The default is “Home” which is good for most scanning. (Other modes are “Office” and 
“Professional,” if needed.) 

 Document Type: Photograph, Positive Film, Negative Color Film, Negative Black and White 
Film, Illustration, Magazine, Newspaper, Text/Line Art 

 Image Type: Color, Grayscale, Black-and-White 

 Destination: Screen/Web, Printer, Other 

 Resolution: Set it at a minimum of 300 DPI for printing. You can set it higher, but keep in 
mind that the higher DPI, the larger the file size. If you are scanning for screen or web, use 72 
or 96 DPI. 

 Target Size: Defaults to “Original” but you can choose other sizes or create custom sizes. 

 Image Adjustments: Descreening (removes moiré pattern); Blacklight Correction (removes 
dark shadows); Color Restoration (may improve color and sharpness);  
Dust Removal (cleans up dust marks and light scratches); Text Enhancement (sharpens text) 

 Brightness/Contrast: Adjust if needed (you may need to check the preview first). 

 Thumbnail view: Check or uncheck box. 

2. To scan a photo or document, place it face down on the document glass with the upper left corner of the 
photo or document at the lower, left corner of the scanner (see arrow). 

 Click on “Preview” to see the initial scan (in either the “Thumbnail” or “Normal” view). 

 Select the image with the marquee. 

 If the preview looks good, click “Scan.”  

 Choose a location where you want to save the file (may default to “Pictures” folder). 

 Type: Save as JPEG, Multi-TIFF, PDF, PICT, Print Image Matching II (JPEG and TIFF), TIFF 
(NOTE 1: Photos are usually saved as JPEGs or TIFFs.) 
(NOTE 2: For a multiple page document, save it as a PDF and it will give you the option to scan  
additional pages.) 

 Options: Quality (used to adjust compression – high or low quality)  

 Check or uncheck boxes at bottom (the defaults are as follows): 

 Overwrite any files with the same name (unchecked) 

 Show this dialog box before next scan (checked) 

 Open Image folder after scanning (checked) 

 Show “Add Page” dialog after scanning. (checked) 

 Click OK to scan. 

SCANNING BASICS 
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3. To scan film negatives or slides, begin by removing the white document mat from inside the scanner  

cover by gently sliding it up. Set it to the side and remove the film/slide holder. 

 Film: 

 Open the film strip holder and slide the film strip all the way into the holder; your images and 

wording should appear backwards on the side that faces up.  

 Close the cover and press down until it clicks. 

 Place the film holder on the glass document table so that it aligns with the tabs (the “film” icon on 

the holder fits in the tab with the same icon on the scanner). 

 Close the scanner cover and start the scan.  

 Slides: 

 Place the film/slide holder so that the “slide” icon fits into the tab with the same icon on the  

scanner. 

 Place up to four slides in the film holder; your images should appear backwards on the side that 

faces up. 

 Close the scanner cover and start the scan. 

 

When finished, be sure to carefully place the film/slide holder and white document mat back in the storage area inside the scanner 

cover.  

 

For more information, click on “Help” at the bottom of the Epson Scan settings window or see the User Guide 

at: files.support.epson.com/pdf/prv37_/prv37_ug.pdf. 

SCANNING BASICS 

https://files.support.epson.com/pdf/prv37_/prv37_ug.pdf.
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Jumbl & Kodak Slide/Film Scanners  

 Check out the Jumbl or Kodak with your Elmhurst library card (For use 
to take home in our Extraordinary Things Collection). 

 All scanners can convert 35mm, 110, 126KPK, super 8 slides and nega-
tives to digital JPEG images.  

How to Use the Scanners 

What You Can Convert: 

35mm, 110, 126KPK and Super 8 Slides and Negatives to digital images 

What You Will Need: 

Slides/negatives to transfer and an SD card (optional) 

How It Works: 

The scanner is a small, stand-alone device that gives you  
a preview on screen and scans in one single image at a time. These images can be saved directly to an SD 
card or they can be saved to a computer when connected via USB cable. The scanner comes with four  
adapters to fit Slides, Negatives, Super 8 and 110 Inserts. 

1. Power the scanner by connecting the power adapter to a wall outlet. Press Power to turn on/off.  

2. Use the Left/Mirror and Right/Flip buttons to scroll between menu items. Use Ok/Enter for selection.  

3. Insert SD card into back. 

4. Place film negatives or slides on the tray. Insert the tray on the right side of the scanner, marked by 
an arrow.  

5. Select “Film Type” from the Home Menu. Select “color negative,” “slide positive,” or “B&W negative” 
from “Film Type” Menu. 

6. Go back to Home Menu. Select “Capture.” Frame up the slide in the display. Press “Convert/Mode.” 
Select “Save.”  

When using your own SD card, be aware that this device may need to reformat your SD card before writing 
to it. Reformatting will erase all data currently saved to your card and you will be unable to restore the infor-
mation. 

For detailed instructions, refer to the manual included in the scanner’s box. 

Source: 
elmhurstpubliclibrary.org/about-us/building-information/creative-studio/creative-studio-slides/  

http://elmhurstpubliclibrary.org/about-us/building-information/creative-studio/creative-studio-slides/
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Wolverine Titan  

 Check out the Wolverine with your Elmhurst library card (for use in 
the Creative Studio). 

 The Wolverine Titan 8-in-1 High-Definition Film to Digital Converter 
can convert 35mm, 110, 126, 127, 8mm, super 8, and 35mm Archive 
Film, slides, and negatives into digital images.  

How to Use the Wolverine Titan 8-in-1  Converter 

What You Will Need: 

Slides/negatives/film to transfer and an SD card (optional) 

How It Works: 

The Wolverine scanner is a small, stand-alone device that gives you a preview on screen and scans one single 
image at a time. These images can be saved directly to an SD card or they can be saved to the device and 
transferred to a computer when connected via USB cable. The scanner comes with six adapters to fit Slides, 
Negatives, Super 8 and 110 Inserts. 

1. Power the Wolverine by connecting the power adapter to a wall outlet. Press Power to turn on/off.  

2. Use the Left/Mirror and Right/Flip buttons to scroll between menu items. Use Ok/Enter for selection.  

3. Insert SD card into back. 

4. Place film negatives or slides on the tray. Insert the tray on the right side of the Wolverine, marked 
by an arrow.  

5. Select “Film Type” from the Home Menu. Select “color negative,” “slide positive,” or “B&W negative” 
from “Film Type” Menu. 

6. Go back to Home Menu. Select “Capture.” Frame up the slide in the display. Press “Convert/Mode.” 
Select “Save.”  

When using your own SD card, be aware that this device may need to reformat your SD card before writing 
to it. Reformatting will erase all data currently saved to your card and you will be unable to restore the infor-
mation. 

For detailed instructions, refer to the manual included in the Wolverine Titan box. 

Source: 
https://www.wolverinedata.com/assets/downloads/F2D_Titan_Manual_V1.pdf 

 

https://www.wolverinedata.com/assets/downloads/F2D_Titan_Manual_V1.pdf


VINYL-TO-MP3  

Using the EZ Vinyl Tape Converter Software 

The latest version of the EZ Vinyl/Tape Converter for Macs automatically import the converted audio into 

iTunes, while the latest version of the EZ Vinyl/Tape Converter for Windows allows you to save your audio 

directly to your computer to any location that you choose.  Windows users can then import the audio tracks 

into whatever audio software you choose. 

All of the steps and windows are the same for both a Mac and a Windows computer minus the very last 

step where a Windows user will choose a location for the audio track and a Mac user will automatically 

have the audio track convert into iTunes/Music.  The following steps walk through the process on a Win-

dows operating system.  

For more resources, visit numark.com/kb/article/1778.  
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EZ VINYL CONVERTER WALKTHROUGH:  

WINDOWS 
Steps for Windows  

1. First, connect the Numark turntable to the computer with the USB cable and ensure that it is powered 

on.  

2. Next, open and run the EZ Vinyl/Tape Converter     

software.  A window that says Step 1: Get  

connected will open up. 

3. Press Next.  In Step 2: Get the music ready to play, 

there are two very important items that can greatly 

affect your recordings: GAIN and the Split recording 

into tracks. 

The GAIN slider is located next to the display meter. 

Its purpose is to control how loud or soft you would like the recording to be. Bringing the slider up will 

increase the volume and down will decrease it. It is very important to make sure the level on the meter is 

not staying in the red. This is called clipping and will cause your recordings to sound very distorted 

The second item is the Split recordings into tracks feature. When this box is checked off, the software will 

automatically advance the recording to the next track when it detects 4-6 seconds of silence  This option 

can be toggled on or off.  

Note: This feature may not function properly on certain types of recordings such as spoken word, live 

recordings, and classical music. Songs with break downs and gaps of silence could trick the software into 

thinking the track is over and advance it to the next song prematurely. In this case is it best to un-check 

the box and record the songs manually. 
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EZ VINYL CONVERTER WALKTHROUGH:  

WINDOWS 

4. Once the GAIN is set to the proper level and you have toggled the Split recordings into tracks function on 

or off, click on the record button to start recording your audio.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

5.   When the recording is complete, choose next.  Then name the Artist, Album, and Track title in the                 

 appropriate locations.  
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CHANGING WHERE THE SONGS ARE STORED: 

WINDOWS 

By default the audio recordings are saved to the Music folder. If you wish to save them in a different location, 

such as your Desktop for example, here is how. 

1. Click on the folder icon. 

 

 

 

 

 

 

 

 

2. Highlight Desktop then click Make New Folder.  

 

 

 

 

 

 

 

 

 

 

3. Name your folder, then click OK. Now by default  

all of your music will be recorded into that folder.  
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STORING FILES ON MAC 

The EZ Vinyl/Tape Converter software steps 1-4 are the same for both Mac and Windows computers.  

However, when using a Mac computer, the EZ Vinyl/Tape Converter software will guide you to step 5 after 

naming the Artist, Album, and Tracks and will automatically import the files to iTunes.  

1. After the Artist, Album, and Track names have been enter, press next and the EZ Vinyl/Tape Converter 

software will continue to Step 5: Exporting to iTunes.  

 

 

 

 

 

 

 

2. When the songs have finished exporting to iTunes, the EZ Vinyl/Tape Converter software will ask if you 

would like to continue recording another album.  

 

 

 

 

 

 

 

3. Even though the recordings have been auto-imported into iTunes, the album can still be located in the   

Music folder on the Mac in the iTunes Media folder. Once located in the iTunes Media folder, the album or 

tracks can be copied to a USB.  
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Import Songs into iTunes Library 

Songs must first be imported into iTunes. Songs can be imported using different compression 

rates to optimize storage on your device. To see what your default Import settings are go to 

iTunes_>Preferences_>Import Settings... 

 

 

 

 

 

 

 

Burning a CD with iTunes 

 AAC:  Use for most music. Use in iTunes, iPhone, 

iPad & iPod models. 

 AIFF: Use if you want to burn high quality CDs 

without losing audio quality. 

 Apple Lossless Encoder: Uses much more disk space. 

Use if you plan to listen on audiophile systems with-

out quality loss. 

 MP3 Encoder: Use if you plan to listen to music in 

apps other than iTunes or on MP3 players other 

than iPod, iPhone, & iPad. 

Creating a Playlist 

To create a playlist you can 

choose File_>New_>Playlist  

or  

Select multiple songs and 

Right-Click to select Add to 

Playlist_>New Playlist. 

Adding Songs to Library 

Go to File_>Add to Library and select song files on your computer that you would like added 

to your itunes Library. iTunes organizes your music into Artists, Albums, and Songs.  
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Adding and Arranging Songs in a Playlist  

 Once you’ve created a new playlist you can easily add songs by dragging and dropping 

them from your Music Library to your playlist. 

 To rearrange songs in your playlist simply click on each track and drag it up or down until it 

is in your preferred order. 

Burning a Playlist to 

CD 

The steps to burn a CD once you 

have your playlist created and in 

order, are simple. Locate your 

playlist on the side panel and 

Right-Click to select Burn 

Playlist to Disc. 

Tip 

A standard CD is limited to 80 

minutes. Be sure that your playlist 

does not exceed 80 minutes. If your 

playlist is longer than 80 minutes, 

iTunes will prompt you to burn your 

playlist to at least 2-discs.  

Playlists will be listed 

on the side panel. 
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Burn Settings 

1. Preferred Speed: can be left at the default unless you experience frequent burn failures. 

If you experience failures, you should select a low speed setting or best match the setting 

listed on your blank media/CD-R Disc. 

2. Disc Format: Audio CD is the selection you want if you desire this disc to be playable in 

all standard CD players. 

3. Gap Between Songs: This is your preferred empty/silence space between tracks in your 

playlist. Note: This time does get added to the total playtime of the disc which cannot ex-

ceed 80-minutes. You can select “None” as an option if you wish. 

4. Use Sound Check: Make this selection if you wish to have all of your tracks play at the 

same volume. 

5. Include CD Text: Make this selection if you want to include information that can be dis-

played in some vehicles and computer systems. 

6. Burn: This will prompt you to insert a blank disc to begin the burning process. 

1 
2 

3 

4 
5 

6 
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The Tascam CD-A580 

The Tascam CD-A580 is a device that will convert cassette tapes 

to MP3 formats stored onto a flash drive. It will also digitize CD’s 

to MP3, and will allow users to create cassette tapes. The Tascam 

does not “burn” CD’s.  

Getting Started 

 Bring a flash drive large enough to store music from your cassette 

 Music files are roughly 10MB per minute—one hour cassette tape will need about 60MB of free space 

 Call Elmhurst Public Library to reserve Creative Studio B for an adequate amount of time 

 The machine converts in real-time, so 1 hour of music will take 1 hour to convert 

How to Transfer Songs from a Cassette to a USB Drive 

 Load the cassette into the Tascam and place the USB drive into the port on the machine 

 Press the SOURCE button repeatedly to select Tape 

 It will scroll between CD, TAPE, or LINE 

3. Press the RECORD USB button to prepare the USB for recording 

 The red indicator above the RECORD USB button and the REC icon on the display will blink  

 Preparation for USB recording takes a few seconds. USB flash drives with larger capacities might take 
more time. When “Record Prepare” is shown during preparation, pressing buttons will have no effect 

5. Before recording, adjust the recording level. Failure to do so could cause the recorded sound to be  
distorted or noisy 

 Play the source (cassette tape) to be recorded 

 Plug headphones into the jack to listen to the tape. (Headphone volume can be adjusted with the 
knob just to the right of the headphone jack.) 

 Use the REC LEVEL knob to adjust the recording level so that the loudest sound never lights the 
“OVER” indicator on the peak level meter shown on the display 

6. Prepare the tape by cueing it to the place where you want to start the recording 

7. Press the RECORD USB button again. The red indicator above the RECORD USB button and the REC icon 
on the display will remain solid, and the tape will automatically play and begin recording to the USB.  

 If you want each song to be a separate file, you will need to divide the files manually. This processed is 
described on page 30 of the user manual.  

8. Press the USB Stop or Cassette Stop to finalize and end the recording. Display will say RECORD ENDING.  

For additional information, see page 28 of the user manual: tascam.com/content/downloads/products/922/
cd-a580_om_e_vb.pdf 

http://www.dupageairport.com/airport-authority/administration/employment/
http://www.dupageairport.com/airport-authority/administration/employment/
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The Tascam CD-A580 

The Tascam CD-A580 is a device that will convert cassette tapes 

to MP3 formats stored onto a flash drive. It will also digitize CD’s 

to MP3, and will allow users to create cassette tapes. The Tascam 

does not “burn” CD’s.  

Getting Started 

 Bring a flash drive large enough to store music from your CD 

 Music files are roughly 10MB per minute, so a one hour cassette tape will require about 600MB of 
free space 

 Call Elmhurst Public Library to reserve Creative Studio B for an adequate amount of time 

 The machine converts in real-time, so 1 hour of music will take 1 hour to convert 

How to Transfer Songs from a Cassette to a USB Drive 

 Load the CD into the Tascam and place the USB drive into the port on the machine 

 Press the Source button repeatedly to select CD 

 It will scroll between CD, TAPE, or LINE 

3. Press the RECORD USB button to prepare the USB for recording 

 The red indicator above the RECORD USB button and the REC icon on the display will blink 

 Preparation for USB recording takes a few seconds. USB flash drives with especially large capacities 
might take more time. When “Record Prepare” is shown during preparation, pressing buttons will 
have no effect 

5. To record all the tracks/files on a CD, stop the disc first 

 To record only some of the tracks, pause at the beginning of the part that you want to record 

6. Press the RECORD USB button again. CD will begin playing and recording will begin.  

7. The red indicator above the RECORD USB button and the REC icon on the display will remain solid 

8. Press the USB Stop or CD Stop button to finalize and end the recording. Display will say RECORD ENDING.  

 

For additional information, see page 28 of the user manual: tascam.com/content/downloads/products/922/
cd-a580_om_e_vb.pdf 

http://www.dupageairport.com/airport-authority/administration/employment/
http://www.dupageairport.com/airport-authority/administration/employment/


VHS TO DVD FOR BEGINNERS 

What is digitization? 

Digitization means changing print or physical materials into some kind of 

digital format. 

Get Organized  

 Find your old family movies on VHS. Try to make an educated guess as to how many minutes of content 

they hold. 

 Buy some DVD-Rs. When you are shopping for DVD-Rs, pay special attention to how many minutes of  

recording time the DVD-R can hold. For example, it might say “120 min.”  

 Set aside some time to come to the Library to do your conversion. The machine works in “real time,” so 1 

hour of video will take 1 hour to convert.  

Help 

 We are here to help, just ask! 

 Toshiba DVD620 complete owner’s manual: 

bit.ly/EPLdvr  

Checkout A Converter 

 Converters are also available to take home. 

Check the catalog for availability at:  

elmlib.org/checkoutvhsdvd 

 VHS-C adapters also available for checkout.  

Start Using Computers, 
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Dubbing Your DVD 

1. Insert the VHS to DVD-R into the machine.  

2. Hit “Play.” Make sure the VHS is playing OK. Use 
the tracking buttons to smooth things out.  

3. Rewind your VHS before the next step. 

4. Hit the [DUBBING] button located behind the 
front panel. (You do not have to press “Play.”) 

5. Grab a book and a cup of coffee and wait! 

Finalizing Your DVD 

6. When your video is done, press [    /    ] on the 
VCR, then wait until the disc reads 100%.  

7. You can put content from more than one VHS  
onto the same DVD. Just go back to step #1.  

8. When you are completely done, use the DVD  
remote to Finalize: 

a. Click [SETUP] on the remote 

b. Select {DVD Menu} on the screen 

c. Select {Finalize} on the screen 

9. To eject your DVD, press [    /    ] on the DVD  
player.  

Legal Information: A self-authored VHS tape that has not been published commercially may be converted into any other format, such as DVD, in 

single or multiple copies. Reproducing / converting a commercial movie is an infringement of copyright.  

Other Digitization Equipment: 

 Vinyl to MP3 Converter 

 DVD to DVD Duplicator 

 Cassette to CD Converter 

 Negative and Slide Scanner 

125 S. Prospect Avenue, Elmhurst, IL 60126 
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http://bit.ly/EPLdvr
elmlib.org/checkoutvhsdvd
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Convert Homemade VHS Tapes Directly to Computer File  

Skip the DVD creation process altogether. Using the Elgato Video Capture device and software, video output 

signals from a VCR or other device can be converted directly to an MPEG or MP4 file that can be viewed and 

edited using a computer and creative software.  

Video Capture Software  

Available for free download from the Elgato Website, the Video Capture software must first be installed in 

order for the device to work. This software may be installed on both Windows and Mac computers. 

Visit the link below and download the version for your computer’s operating system. 

https://www.elgato.com/en/video-capture/support 

Disclaimer: The copyright law of the United States (Title 17, U.S. Code) governs the making of photocopies 

or other reproductions of copyrighted material. The person using equipment is responsible for any infringe-

ment.  

Instructions After Installing Software 

1. Connect the Elgato Video Capture device to an open 

USB port on your computer. 

2. Open the Elgato Video Capture application on your com-

puter. If it asks you to register your product, you may 

choose to “Skip Registration.” 

3. You should see a “Get Started” screen. 

4. Enter in the name of your movie, for example “Wedding 

1983.” 

5. Select the length of your video. If accurate, this will give 

you the estimated amount of hard disk space required 

to save this file onto your computer or flash drive.  

6. Check your preferences to select where your recording 

will be saved on your computer.  

From a Windows computer, “Preferences” is located at the 

bottom of the application window. 

From a Mac, go to the top of the screen and click on “Elgato 

Video Capture” and select “Preferences.”  

Elgato Video Capture 

https://www.elgato.com/en/video-capture/support
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Instructions Continued 

7. Select “Continue.” 

8. Connect the RCA cables from the Elgato Video Capture device to the Video Output of your VCR, Camcord-

er, or other peripheral device.  

9. Prepare your VCR, camcorder, or other peripheral device for playback. Once connected properly you 

should no longer see “No Signal” displayed on your computer; when you play your video you should see it 

play through your computer. 

10. Select the proper aspect ratio: either 4:3 or 16:9. Note: most older videos will be 4:3. For best results, 

match the original footage aspect ratio. You will notice your video is stretched a bit if the wrong format is 

selected. 

11. Select “Continue.” 

12. This next screen tests for audio playback. If your source video contains audio, you should see the audio 

levels and be able to hear the audio play back through your computer. 

13. Select “Continue.” 

14. Now you are ready to record. You should see a large, red “Start Recording” button in the lower right side 

of the window. 

15. Once you have the tape at the beginning, or where you would like to begin the recording, simultaneously 

hit play on the VCR, camcorder, or other peripheral device and click “Start Recording.” 

16. When your tape has finished, click “Stop Recording.” 

17. You will be brought to a trimming screen.  

18. Here, dead footage at the beginning and end of your recording may be cut from the recording by using 

the trimming feature.  

19. Drag the slider on the lower left to where you want the beginning to start and drag the slider on the low-

er right to the spot where you want your recording to end. 

20. Click “Continue.” 

21. You will see that your video has been saved to your computer or external storage device and you can 

choose to quit or continue with the options Elgato provides.  


